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How to remove a password in word

By Contributor A password stealer is a type of computer virus that infects your machine, records all of your user passwords and then emails them to a remote user. This is a dangerous type of virus because it can compromise your email and bank accounts. It can steal passwords from programs like Windows, Internet Explorer, your email and other
types software. The password stealer program will start up automatically every time Windows loads, so rebooting the computer after you remove the threat is essential. Manually Delete the FilePress the "Ctrl" + "Alt" + "Delete" keys at the same time to open Windows Task Manager.Click the "Processes" tab. Locate the process "lpr123.exe" on the list
of running processes.Click once on "lpr123.exe" to highlight it and then click "End Process" to stop it from running.Delete Registry ValuesClick the "Start" menu to open, then click "Run."Type "regedit" into the Run box that has opened.Select "HKEY LOCAL MACHINE" on the left pane.Search for the registry value that starts

withHKEY LOCAL MACHINE\Software\Microsoft\Windows\CurrentVersion\Run\lprRight-click on it and delete it.Delete the FileClick the "Start" menu to open it, and click "Search."Type "lpr123.exe" into the Search field to locate the file.Record the file's location.Click the "Start" menu, then "My Computer and then the "C:" drive. Find the file and
delete it.Important: Do not reboot your computer until you stop the process from running, remove the registry values and delete the files. Otherwise, the virus may replicate when you reboot. By Sabrina Ashley Many software programs offer an extra layer of security. These programs require a password to run or uninstall the program. For financial
software and other programs that contain sensitive and confidential information, password protection provides safety. Removing password protected programs takes just a few steps. Click on the "Start" menu. Click "Programs," and then click "Programs and Features" for Vista and Windows 7. Search the program list for the password-protected
program you want to uninstall. Click on it. Click the "Uninstall" button for Vista and Windows 7. Enter the program's password when prompted to do so. Hit the "Enter" key. Confirm removal of the program. Not everyone likes having to enter a password every time they need to sign in to their computer. Windows lets you get rid of the password
without too much hassle. Here’s how. Why You Probably Shouldn’t Do This There are several caveats you should be aware of before you even consider using the techniques we cover in this article. You must be using a local account for the password removal trick to work. You can’t remove your password if you're using a Microsoft account. If you're
using a Microsoft account and still want to do this, you’ll need to revert your account to a local one. Removing the password from your computer can be a security risk. Anyone can access it by simply walking up to it. However, people still need to have physical access to do this. Having no password on a local account doesn’t make you any more
vulnerable to remote intrusion. If you make an administrator account have no password, malicious applications running on your PC could theoretically gain elevated access to Windows. If you have only one account on your Windows PC, it’s a better idea to set Windows up to sign you in automatically instead of removing your password, but even that
has its problems. We’ll show you how to do it later in this article and note the specific security risks it entails, as well. Yeah, that’s a lot of important caveats. The truth is, we generally recommend against using these techniques, even though, in certain circumstances, they might make sense. In the end, we’re writing about them because we’ve seen
the advice passed around on other sites without noting the important risks it involves. How to Remove the Windows Password for a Local User Account Open the Settings app by clicking the Start menu and then the Settings cog. Next, click on “Accounts.” From the list of settings on the left side, select “Sign-in Options” and then under the “Password”
section on the right, click the “Change” button. To change your password, you must first confirm your current one, for security reasons. Once you have done that, click “Next.” For the next section, because we don’t want to use a password to sign in, leave all the fields blank and click “Next.” By not entering a password and leaving it blank, Windows
replaces your current one with a blank one. Finally, click “Finish.” Alternatively, if you feel more comfortable in the command line, fire up an elevated Command Prompt and enter the following command, replacing username with the name of the user account (be sure to include the quotes in the command): net user "username" "" The next time you go
to log in, all you have to do is click “Sign in” for the account you just changed. How to Automatically Sign Into Windows If you have only one user account on your PC, automatically signing in is the better option. Note that there is a security risk with this method, too. First up, the same thing applies that we mentioned before: Anyone can walk up to
your PC and sign themselves in. What’s more, when you enable it Windows stores your account password on your PC where anyone with admin access can find it. Again, this isn’t too big a deal if your PC is in a secure location accessible only by people you trust (like maybe in your home), but it’s not a good idea on a laptop you carry around with you,
and it’s certainly not a good idea if you use a Microsoft account rather than a local one. We’ve got a full article detailing the risks with setting automatic login that you might want to read before enabling it. RELATED: Why You Shouldn't Automatically Log Into Your Windows PC If you do want to have Windows automatically sign you in, it’s easy to set
up. Run the command netplwiz from the Start Menu or Command Prompt. In the User Accounts window that opens, untick the “Users must enter a user name and password to use this computer” checkbox and then click “OK.” One last option has to be turned off to make sure you never have to use a password to sign in again. In the Settings app,
head on over to Settings > Accounts > Sign-in options, and under “Require Sign-in” select “Never” from the drop-down list. RELATED: Why You Shouldn't Automatically Log Into Your Windows PC Now, anytime you’ve been away from the computer and wake it back up, you won’t need to input any password to sign in to your account. RELATED: How
to Make Your Windows 10, 8, or 7 PC Log In Automatically Leaving comments in a Word document is a good way to leave feedback on a piece you're reviewing. If the issue you commented on has been resolved, you can remove the note to keep things looking clean. Here’s how. How to Add Comments in Word First, open a Word document

and highlight the content that you would like to leave a comment on. Once selected, head over to the “Review” tab and select “New Comment”, which is found in the “Comments” group. Next, type the comment you would like to leave. That’s all there is to it. Repeat this step for as many comments as you need to leave in the piece. How to Reply to
Comments in Word If you want to leave feedback on the comment that was already left, simply hover over the comment and click the “Reply” button. Now, type out your reply and save the response. How to Delete or Resolve Comments in Word Resolving a comment keeps the comment but shows it as “Resolved” so those collaborating on the piece
can see the issue has been fixed. Deleting the comment removes it completely. If you want other teammates to know an issue was dealt with, use “Resolve”. If you want to clean up some comments in the sidebar, use “Delete”. To resolve a comment, hover over the comment and click the “Resolve” button. The comment will remain in the sidebar, but it
will be grayed out to show the comment has been resolved. To delete a comment, right-click the item and select “Delete”. Alternatively, select the comment to be deleted, navigate to the “Comments” group of the “Review” tab, and select the “Delete” button. If you have a lot of comments in the Word document that you would like to delete all at once,
select the arrow under “Delete” and then select the “Delete All Comments In Document” option. How to Reopen a Comment in Word If a comment was previously marked as resolved but you need to leave further feedback, you can reopen the comment by right-clicking it and selecting “Reopen Comment”. This only works if the comment was marked
as “Resolved” and not deleted. Open the document, then click File > Protect Document > Encrypt with Password to get started. You can change the password or remove it entirely at any time but you will need access to the file to do so. This article explains how to unlock Word documents and the best way to remove passwords from Word documents
when you forget what your secret code is. Instructions in this article apply to Microsoft Word for Microsoft 365, Word 2019, Word 2016, and Word 2013. Protecting a Microsoft Word document with a password is easy due to the fact that the program itself contains its own free password feature. Here’s how to use it to lock your doc. Open the Word
document that you want to protect. You can also add a password to a new Word file as soon as you create it if you like. Choose File. Select Info > Protect Document. Click Encrypt with Password. Enter a password into the field and select OK. Your password will be hidden from you as you type it so be very careful with what you type. Enter the same
password you just created a second time. This is done to ensure that you know the password that you’'re setting and that you didn’t make a spelling mistake the first time. Select OK. If you haven’t already, write down the file name and its password in a separate file that’s backed up to the cloud in case you forget it later on. Microsoft OneNote or
Evernote are ideal for situations like this. Save your file as usual. The Microsoft Word document now requires your password to be opened. If you're sending a locked Word doc to a friend or colleague, you don’t need to worry about teaching them how to manage password protected files as the Word document automatically asks for the password as
soon as anyone attempts to open it. Likewise, if someone sends you a Word document with a password, the program will prompt you to enter the password right away. Even though you’re the person who added the password to the Word document, the file still asks you for the password every time you open it. You can change the password or remove it
entirely any time you want, but you need access to the file to do so. You need the current password to change or delete it. Here’s what you do to edit the Microsoft Word document’s password. Open the Word doc as usual and click File. Click Info > Protect Document. Click Encrypt with Password. Delete the hidden characters in the text field and click
OK to remove password from the Word document. Enter a new password in the field and click OK to change the Word doc’s password. If you forget the password for your Word document and you can’t find your record of it that you wrote down when you created it, there is still a way to gain access to the file’s contents. To unlock Word documents that
are protected by a password, you need to use a brute-force password recovery program. Many of these programs contain malware and require a payment to use, and a lot of them no longer work since Microsoft increased its security. A good free option is the Password Find website, which can unlock protected files directly on the site and doesn’t
require the installation of any suspicious software. The unlocking process is also free and easy to use. Open your preferred web browser and go to this page on the Password Find website. Click Browse and select the password-protected Word document that you want to access. Click Next Step. Click the bullet point next to Remove password and
select Next step. This option gives you access to the Word file’s contents and is free. The Find password option requires payment and tells you the password. After several minutes, the process is complete, and you are provided with the option to download the password-free document or view it online as a Google Doc. You can also click Delete to
remove the file from the site’s servers. Thanks for letting us know! Tell us why! File sharing increases the risk that certain kinds of document metadata (stuff that's embedded in a file, often without your knowledge) could leak online, such as who worked on a document or who commented on a document. Word features a built-in tool to help you find
and remove personal information and other hidden data. Information in this article applies to Word for Microsoft 365, Word 2019, Word 2016, and Word for Mac. Microsoft Word includes a tool called Document Inspector that removes personal information from your document before you share it with others. When you print a document and want to
avoid printing comments, go to File > Print, select Print All Pages, and clear the Print Markup check box. Open the Word document you want to remove any personal information from. Wait until the document is completed before you remove the personal information, particularly when collaborating with other users because names associated with
comments and document versions change to “Author,” making it difficult to ascertain who made changes to the document. Select the File tab and choose Info. In the Inspect Document section, select Check for Issues. In the drop-down menu that opens, select Inspect Document. The Document Inspector window will open. Document Inspector only
runs on a saved file. It prompts you to save your work-in-progress if you haven't manually saved a changed file. Select the Document Properties and Personal Information check box as well as any other items you want the tool to check for. Scroll down to see all the available options. If in doubt, select all the check boxes. Select Inspect. Wait while the
Document Inspector checks the document. In the Document Properties and Personal Information section, select Remove All to remove the document and author properties associated with that file. Select Remove All next to other results if you wish to remove other information the Document Inspector discovers. Some changes cannot be undone, so
make sure you want to remove them before proceeding. When you next save the document, this information is removed. Don't worry about Microsoft having access to personal information in the documents on your computer. Unless you were to send a document to Microsoft, they do not have access to any information from your documents. Thanks for
letting us know! Tell us why!
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